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16m2 – adj, The smallest size of land parcel that can be created in Second Life. Often used for single
prim servers or eyesore ads.

Abuse – n, A violation of Second Life's Terms of Service or Community Standards.
Access List – n, See Admit List.
Ad Farm – n, Clusters of rotating towers of advertisements, considered by many to be an eyesore,
now restricted and regulated by Linden Lab.

Aditi – n, The name of the server network known as the Preview Grid, q.v. (formerly called the Beta
Grid).

Admit List – n, The list of those allowed in an area that otherwise excludes everyone by use of a
script, or enforced by land management tools.

Advanced Menu – n, A normally hidden menu in the Second Life client that allows access to extra
commands. The Advanced menu can be toggled on/off by typing CtrlAltD (or CtrlAltShiftD for
Linux).

AFK – adj, “Away From Keyboard.” Describes a player who has left his computer to take care of

some task in Real Life (RL). Typing “afk” in chat sets your Avatar as “Away” and displays the word
(Away) next to their name. After 30 minutes of inactivity, you will be automatically logged off Second
Life.

Agent – n, Geeky term for your loggedin presence on a simulator. While “avatar” refers to the shape
mesh and its appearance and requires the cooperation of a sim server, “agent” refers to a successful
login to the Linden Lab grid and does not necessarily require a connection to any specific sim or an
avatar representation (e.g., for textonly thin clients).

Agent Domain – n, A set of Linden Lab servers that manage logins to Second Life, manipulation of
avatar inventories, profiles, and other agentspecific information. Closely related to Agent Storage
Cluster.

Agent Storage Cluster – n, The databases on Linden Lab servers that hold all residents' inventories,
profiles, login information, and other agentspecific data. Closely related to Agent Domain, q.v.

Agni – n, The name of the server network that contains the Main Grid and Teen Grid. (Also see Aditi
for the Preview Grid.)

Alpha – adj, Transparent, from Alpha Channel (q.v.).
Alpha Channel – n, A special channel of a texture file used to indicate transparency, marking which
parts of the image should be clear and which should be opaque.

Alpha Ordering – n, Or, Alpha Sort Ordering, this refers to a quirk of OpenGL (which the client

uses) that causes two surfaces with alpha channels (q.v.) to be incorrectly rendered as if the farther one
were nearer the viewer. This is often seen when parts of hair, skirts, and shoes flash in and out of
existence as the transparent areas in the scene move in relation to each other. (Also called Alpha
Flicker.)

Alt – n, “Alternate Account.” Many Second Life residents have more than one account for a variety of

reasons, including: keeping one’s business life separate from social life, roleplaying, avoiding
harassment, keeping track of L$ (bank alts), and being able to work uninterrupted by Instant Messages.

Animation – n, A file or inworld inventory item that moves or animates your avatar. You can use
animations to make your avatar walk, sit, clap their hands, dance, blow someone a kiss, and much
more.

AntiIdle – n, Refers to staying online for a long period without being automatically logged off. This
is accomplished by wearing a scripted gadget or disabling the option at Client>Character>Character
Test>Go away/AFK when idle.

AO – n, Animation Overrider; a scripted device that contains replacements for the default walking,

sitting, flying, and standing animations of your avatar. Some also have other functions. Some AOs can
be customized by loading your own animations. Some AOs must be turned off before engaging in
poseball or other animations, since the animations can conflict with one another.

AR – 1. n, Abuse Report; a formal report to Linden Lab of a violation of community standards or SL
terms of service. 2. v, The act of filing an Abuse Report (“I AR'd the guy.”)

ARC – n, “Avatar Rending Cost.” This is a number in the range of 1 to about 20,000 that is an

approximation of how much processing power is consumed by a client to process and render an avatar,
including all the avatar's clothing, attachments, including scripted attachments. This number can be
displayed in the standard client by enabling it in Advanced>Rendering>Info Displays.

Asset Server – n, The database that tracks all Second Life objects inworld and in inventory.

Overloaded asset servers can cause search, inventory, rez, teleport, and Friends list failures.

Attach – v, To connect an object from inventory or inworld to a certain place on your avatar's body,
or in the case of a HUD, to some location on the user's screen.

Attachment – n, An object (clothing, weapons, jewelry, shoes, HUD, etc) that can be connected to an
avatar at a specific location, or in the case of HUD, to a location on the user's screen. Typically the
location is set by the creator of the object, but may be changed by the owner.

AutoReturn – n, A feature on land parcels in which objects that don't belong to the land owner or

group are returned to their respective owners' inventory after a certain period of time. This helps reduce
intentional and accidental litter on land parcels. The parcel's autoreturn time period can be set in the
Objects tab of Preferences.

Av – n, Also “avi”, an abbreviation for Avatar, q.v.
Avatar – 1. n, The animated being that represents a Second Life resident in the virtual world; the
digital representation of your virtual self in Second Life. 2. n, A “costume” or outfit; a full set of avatar
body parts, clothing, and/or attachments that provides a specific look.

Avatar Key – n, The unique identifier assigned by the SL database to each Avatar, the Avatar's
UUID.

AWG – n, “Architecture Working Group.” A group of Linden Lab employees, Second Life

developers, and interested residents who are working toward a set of protocols that can be used to make
the Second Life grid more robust and scalable while allowing interoperability with other grids.

Baked – adj, Refers to the mechanism within the client where the various layers of skin and clothing

are collapsed into a single texture, uploaded to the servers, then downloaded to anyone within viewing
distance. This causes newly donned skin and clothing to look clear and sharply defined, then fuzzy,
then sharp again. The end result is that everyone, including you, sees the identical clothing texture.

Ban – 1. v, The act of explicitly forbidding entry to a land parcel. 2. v. To add someone to your ban list
and thus eject them from your land. 3. v. Permanent removal of someone from Second Life (which can
only be done by Linden Lab).

Ban Lines – n, Lines of floating red letters spelling out “no entry” that appear on the boundaries of a
land parcel that your Avatar is not allowed into by the owner.

Banlink – n, Distributed ban sharing system developed by Travis Lambert and Mera Pixel that allows
subscribing locations to share ban lists.

Ban List – n, The list of those banned from an area, by use of a script, the parcel or estate land
management tools, or by Landban, that otherwise allows visitors.

Beacon – n, An indicator of location. These take many forms, such as a red circle on the map and
minimap displays, or a tall fuzzy red line and an arrow showing the final location of a teleport
destination, or tall lines of various colors with wireframe crosshair boxes when View>Beacons is
activated.

Beta Grid – Obsolete name for Preview Grid and Aditi, q.v.
BIAB – n, “Business In A Box.” Often sold to newcomers as an easy way to make money, BIAB

packages may contain merchandise that is poor quality, out of date, stolen from the original creators, or
available elsewhere for free.

Bling – n, Jewelry and other attachments scripted to emit particle based shimmering “bling” effects.
Blingtard – n, Pejorative term for a user, often a newbie, who wears too many blinging
attachments.Body Part – n, A component of an Avatar; shape, skin, hair, eyes, and/or prim

attachments are Body Parts that combine to create an Avatar's form. Different body parts can be created
and saved to a user's inventory and switched between as the mood strikes.

Blog – 1. n, An online journal of information. Linden Lab's official blog is http://blog.secondlife.com
and contains official announcements about Second Life upgrades, new viewers, planned downtime,
new policies, and much more. 2. v, The act of adding content to a blog.

Borked – v, adj, Messed up, broken. “The teleport function is borked again”
Bot – n, An alt account run by a computer. (see Landbot)
Boxhead – v, The act of wearing an object, usually a package prim, on your head or other location.

Package prims are meant to be rezzed on the ground, but newcomers often mistake them for the
object(s) they contain, and try to wear them instead. Originally the default attachment point for objects
was the head. Later updates of the Second Life client changed that to the right hand.

BRB – v, adj, “Be Right Back,” shorthand meant to imply that the speaker is away from the keyboard
for a moment, but will return very shortly.

BTW – “By the Way”
Build – 1. v, To create/make something out of primitives in Second Life, 2. n, An object comprised of
one or more primitives, 3. n, An engineering term for a specific version of the Second Life (or other)
software.

Bumpmap – n, An extra texture layer on objects that adds “bumpiness” to them. This can provide the
illusion of detail by resembling wood bark, cut stone or a number of threedimensional surfaces.
Second Life offers only limited bumpmapping.

Busy Mode – n, A mode where your Avatar does not hear nearby chat, where IMs receive the “busy
mode” response, and all inventory and teleport offers are automatically declined.

BVH – The file format used for creating animations.
Cache – n, A disk file on your local computer that retains copies of textures and other data when they
are first encountered and downloaded so that subsequent visits to the same location will render more
quickly.

Cage – v, To trap an avatar in place by rezzing (q.v.) an object that surrounds them. Caging an avatar
who has not consented to is an AR'able (q.v.) offense.

Cage Gun – n, A gun that fires a Cage (q.v.) that rezzes around an avatar, trapping them. The quickest
ways to get out of a Cage is to either a) teleport to your home location, or b) rightclick on a nearby sit
target, and you will be popped out of the Cage and seated there..

Calling Card – n, An item with a player's name that goes into the Calling Card section of your

inventory. Calling cards serve as a contact list of sorts. Double clicking on a Card opens an IM window
to that person. Offering a Calling Card is similar, but less personal than offering Friendship, and can be
done from second level of the avatar pie menu.

Camera – n, The particular viewpoint from which you see the Second Life world. Normally, your

camera is behind your avatar. Second Life allows you to move your camera around in many different
ways to see things from many different viewpoints.

Camping – v, The practice of earning small amounts of $L by sitting on a chair or engaging in menial
activities. Merchants use campers to make their store look more popular on the grid map.

Capability – n, In the software protocols that connect a client with the Linden Lab servers, a

capability refers to the granting of access to a specific server resource (a data item, object, service, etc.)
by a server to a client.

Central Database Cluster – n, The set of Linden Lab servers that includes the Asset Storage Cluster
(asset database), Central Database Cluster (profiles, regions, groups, classifieds), Agent Database
Cluster (inventories, agent login information), and a few other minor databases.

Channel – 1. n, An integer number that refers to the Chat Channel (q.v.) used by scripts or avatars. 2.
n, Refers to the variation of server or client software in use. Examples of server channels include the
main grid server, and experimental server versions currently being tested on the Preview Grid.
Examples of client channels include the main viewer and First Look viewer.

Chat Channel – n, One of the “pseudofrequencies” that objects and avatars can chat on. Avatars

normally speak on channel 0, and can only hear chat on channel 0. Objects can chat and listen on any

channel. SL supports are 4,294,967,294 possible channels, ranging from 2,147,483,648 to
2,147,483,647.

City Sims – n, A set of four Linden designed sims (Sistiana, Barcola, Miramare and Grignano) meant
to represent a city. These are the only mainland sims with a Simulator Object Bonus (q.v.).
Approximately half of each city sim is composed of Lindenowned lowprim streets and walkways,
allowing owners of the available space to use twice the prims they normally could.

Clear Cache – v, The act of setting the SL client to clear its local storage of SLrelated data and

textures the next time it is started. Often problems with slowloading textures can be fixed by clearing
your cache. Clearing your cache can also make missing inventory items reappear.

Client – n, Second Life consists of two software parts. The client, or viewer, resides on the user's
computer. The server resides in a remote location.

Client Menu – n, A normally hidden menu in the Second Life client that allows access to extra
commands. The Client menu can be toggled on/off by typing CtrlAltD.

Clothing Layers – n, Jacket, shirt, pants, undershirt, underpants, gloves, socks, shoes, skirt, skin, and
tattoothe parts of your avatar that are worn on top of its body and created and edited in appearance
edit mode. You can create different Outfits (q.v.) of clothing and save them in your inventory, then
switch between them as the mood strikes. You can even design your own clothing and upload the
textures to Second Life.

Coalesced Item  n, An item in your inventory that is a collection of many objects. When more than
one object is returned to you from someone's land, the objects are often combined into one or more
consolidated objects so that you won't receive a multitude of individual items. A coalesced inventory
item appears in your inventory window with an icon that looks like a stack of cubes. The name of a
coalesced inventory item will be the same as the name of one of the objects inside it. The only way to
determine what objects are contained inside a coalesced object is to rez the coalesced item.

Colo – n., A realworld facility where servers, networking, and communications facilities are housed
and managed.

Combat Region – n, A region where the parcel “Safe” setting has been disabled, so that avatars can
sustain damage (q.v.), and where weapons and combat are allowed.

Community Standards – n, The agreement all players subscribe to which determines the limits of
appropriate behavior while playing the game. The Community Standards are incorporated into the
Terms of Service (q.v.) by reference.

Concierge Service – n, A higher level of customer service and assistance available only to island

owners and mainland land owners paying more than 125US$ per month in tier. This service level
includes Lindens dedicated to Concierge support duties and tollfree Concierge levelonly phone help.

Console – n, Any of several windows that can be made to appear on the user's screen to display details
about the internal operation of the client. These are useful to investigate client performance problems.
Consoles may be enabled/disabled in the Client Menu (q.v.) or with keyboard shortcuts, and include
Frame, Texture, Debug, Fast Timers, and Memory consoles.

Copybot – n, A gadget and a technique developed from the efforts of the libopenmv (libsecondlife)

project, consisting of scripts and clientside software capable of making unauthorized copies of objects
that were meant to be noncopyable or nontransferable. Its use is a serious violation of the TOS.

Covenant – n, Stipulations made by the private estate land owner of what the next parcel owner may
or may not do with the land. A parcel's covenant may be seen in About Land, Covenant tab. Also see
Zoning.

Culling – n, v, Refers to how a viewer doesn't bother rendering objects, avatars, particles, and other
visual elements that are hidden behind other solid objects.. It's a performance feature.

Cyber – v, Short for cybersex. The practice of engaging in sexual roleplay using chat and Second Life
avatars and animations.

Damage – n, In certain regions, it is possible for an avatar to experience “injury” resulting in a loss of
points that may result in death. At that point, the avatar is teleported to its Home and the points are
restored. Damageenabled areas can be set for one parcel or for an entire region. If you are in a
damageenabled zone, you will see a red heart at the bottom of your screen with a number showing
points from 1 to 100. The overwhelming majority of Second Life is not damageenabled. Also see
Combat Region.

Dance Balls – n, Pairs (or larger sets) of pose balls (q.v.) which synchronise with each other to create
animations showing avatars dancing or interacting in various ways. Also called Couples Balls.

Dataserver – n, Refers to the way LSL scripts request information from Linden Lab databases.
Day – n, The default SL day is four hours long, consisting of three hours of daytime and one hour of
nighttime. The default cycle may be overridden on private estates.

Dazzle – n, The project name for a look and feel (a “theme”) for the Second Life viewer, which is now
the default light blue theme.

Death – n, When your avatar is in an area that allows damage to occur, a red heart will appear at the

bottom of the screen. Next to it is a number that is initially set to 100 percent. If the amount of damage
your avatar suffers drops to zero, the avatar dies. It is then teleported to Home and the points are set
back to 100%.

Deed – 1. v, To give a parcel of land to a group. The group must already have enough tier contributed
it to own the land. 2. v, To give a tier contribution to a group so it can own land. Usually done via the

Owner Makes Contribution With Deed checkbox. 3. v, To give an object to a group. The object
becomes the property of the group.

Derez – v, To remove (derez) an object from a sim within Second Life. Generally is done through
deleting the object or taking the object into inventory.

Detach – v, Usually, to remove an item that has been attached to a specific part of the avatar's body, or
in the case of HUD, to a location on the screen, and return it to inventory.

Developers Incentives – n, A now discontinued Second Life feature that paid US$ awards to the
owners of the locations with extremely high Traffic.

DMCA – n. “Digital Millennium Copyright Act,” a set of laws and conventions that allow copyright
holders to notify a service provider of copyright infringements so that the service provider can help
remove the illegally reproduced items.

Draw Distance – n, The radius centered on your avatar that your client renders the Second Life

world. If you are on a slower computer, you may be able to speed up your Second Life experience by
reducing your Draw Distance.

Drop – 1. v, To remove an attached item from your avatar and drop it on the ground, instead of
returning it to your inventory. 2. v, To place an inventory item on an avatar or a calling card.

Dwell – n, A now discontinued Second Life feature that paid land owners in L$ according to their
land's Traffic. Sometimes mistakenly used as a synonym for Traffic.

Eject – v, To expel an avatar from a property. Ejecting a user will cause them to be quickly hurled off
your property. The user can come directly back on your property after being ejected unless you also
Ban (q.v.) them. Also called Boot or Kick.

Emote – n, A builtin facial animation such as smile, or raise eyebrows, which may be triggered by a
script. These are different than normal animations in that they are predefined, builtin, cannot be
modified, and no new ones may be uploaded.

Estate – n, A collection of one or more private sims owned by the same individual. An estate contains
one or more regions (sims); a region (sim) contains one or more parcels.

Estate Controls – n, Local preferences menu (such as sun position, ground texture, and other things

that only affect the regions in that estate). Estate controls (World > Estate... menu) are only available to
private island owners. Residents who own mainland sims can not access them.

Event – 1. n, A group activity, led by a host, that starts and ends at specific times, and can be

legitimately listed on the Search/Events calendar. 2. n, In the context of scripting, events are what
triggers the execution of blocks of code. There are more than thirty possible events that scripts respond

to, such as collision with another object, hearing chat, or detecting a mouse click.

Face Light – n, A type of attachment consisting of an invisible scripted prim that acts as a light
source, to better illuminate the avatar's face.

FIC – n, Forum InCrowd or Feted Inner Core; originally a term for SL residents who received

unusual access or special treatment from Linden Lab, it has now become more general to refer to any
influential SL resident (“She so FIC”). FIC originated at a time when the Forums were more widely
used and were frequented by Lindens.

First Land – n, A now discontinued feature of Second Life. Formerly Premium Accounts were
entitled to a free 512m2 plot of land from Linden Lab.

First Life – n, The socalled “real world” away from Second Life. Synonym for Real Life. Possibly an
illusion.

First Look – n, A version of the Second Life client that contains a major enhancement currently being
tested on the Main Grid for a nearfuture release. Residents can often use the Second Life First Look
software and try out new features.

FL – n, Abbreviation for First Life, q.v.
Flexi, Flexible, Flexified – adj, Refers to an attribute of prims that allows them to be subject to
gravity, wind, avatar movement, and other forces. Commonly used in skirts and hair to simulate
realistic movement.

Flight Assist – n, A scripted attachment that can be worn to enable an avatar to fly higher and/or
faster than the normal limits.

Floater – n, A temporary window that pops up in the Second Life viewer user interface. Examples
include the inventory window (CtrlI), friends list (CtrlShiftF), edit window (Ctrl3), etc.

FPS – “Frames Per Second.” Two important FPS measures of performance are the client FPS (seen in
the top of the Statistics Bar [q.v.], about 1020 fps for most of us) and the simulator frame rate (“Sim
FPS” farther down in the Statistics Bar, normally 45 for a smoothly running sim).

Frame Time – n, A simulator has about 22.2 milliseconds per frame to update all its periodic

calculations for physics, scripts, texture handling, avatar control, etc. The actual time the simulator
spends doing the processing is shown in the Statistics Bar, in the section named Time. A sim starts to
get laggy when the frame time reported starts to reach the alloted 22.2 milliseconds.

Freebie – n, An item made available at no cost, often with full or extremely generous permissions.
Freebie Resale – v, The practice of selling items at a cost, which are available elsewhere for free.

Reselling freebies is generally considered a scam in Second Life.

Freebie Wall – n, A scripted device offering a “catalogue” of Freebies from which a user can choose
from by clicking on a prim representing the desired Freebie. The first Freebie Walls were provided by
the Lindens at Telehubs (q.v.), labeled “Free Linden Content”.

Freeze – v, A function used by landowners to bring a havocwreaking resident under control. Once
frozen, an avatar stops flying, falls to the ground, and is unable to move.

Friendship – n, A relationship between two residents that enables them to see each other's online
status, inworld location, and gain easily access to each other's profiles.

Full Perms – adj, Full Permissions; an object set so it can be freely copied, modified, and transferred.
Furry – n, Second Life resident using anthropomorphic animal avatars.
Gadget – n, A particular form of scripted item; usually one that is a) worn by its user; and b) focuses
on providing that user with extra functions, as opposed to doing anything externally visible. HUDs
(q.v.) and AOs (q.v.) are common Gadgets.

Gesture – n, Gestures are unique combination of sound, animation, and chat that can be preconfigured
to go off with a command or a specific phrase (for example, you can have your avatar clap his or her
hands and play the sound of applause whenever you type: /clap). A Gesture is a wrapper that contains
references to one or more animations and sounds in your inventory, and a simple rule set that defines
the sequence that they should be applied.

Ghost – n, An object or avatar that is no longer in the Second Life virtual world, but is still visible on
at least one resident's client.

GIRL – n, “Guy In Real Life,” a sarcastic term for a female avatar controlled by a male player.
God Mode – n, A special mode of Second Life which only Linden staff members can access. A

Linden in God Mode is invisible to sensors, cannot be pushed or damaged, has unlimited L$ and has
full permissions access to every object on the grid. All actions that Lindens engage in while using God
Mode are logged and inspected; any use of these powers for other than testing and legitimate
administration purposes will usually lead to them getting fired,

GOM – 1. n, Gaming Open Market, a now obsolete currency exchange service, which closed down in
response to the creation of LindeX. 2. v, To GOM, meaning for the Lindens to create a service which
competes with something a resident was already providing (“I hear the Lindens are planning to GOM
banlink in the next release.”)

Gor – n, Series of BDSMoriented Science Fantasy novels by John Norman that have given rise to
dozens of roleplaying sims throughout Second Life.

Gorean – n, Second Life resident who identifies with the culture of one or more of the various Gor
sims.

Grey Goo – n, An object which continuously makes copies of itself. Can be produced by accident, but
is generally considered a form of Grid Attack, q.v.

Grid – 1. n, The network of servers that make up the Second Life world (Example: “The Grid is down

so the Lindens can fix it.”) 2. n, A series of intersecting lines that give a regular reference for building.

Grid Address – n, Also called Grid Coordinates, the name of a region combined with three numbers

between 0 and 255 for the X & Y (eastwest and northsouth) coordinates, and from 0 and larger for the
Z (updown) coordinate. Example: Ahern (200, 155, 50).

Grid Attack – n, A coordinated attempt by griefers to crash Second Life as a whole, or multiple

servers within it. Attempting a grid attack is grounds for instant and permanent banning from Second
Life.

Grid Coordinates – n, See Grid Address.
Grid Monkey – n, A Linden (which varies at any given time) assigned to care for the grid and resolve
hardware and software issues. There usually is a gridmonkey oncall at all hours of the day/night,
making sure someone is ready to take care of any issues at all times.

Gridnaut – n, A resident who teleports between different virtual world grids, such as between Second
Life and OpenSim grids.

Griefer – n, A person whose primary purpose is to harass others and destroy their enjoyment of
Second Life. Griefers should be Abuse Reported.

Group – n, An inworld playercreated association. Belonging to a group also includes the ability for
several avatars to work on one project or administer a common parcel of land.

Group Title – n, The labels designated for officers and members of a group. Group Titles appear over
an avatar's name when that group is active. You can change that title by changing your Active Group.
To change that, right click on your Avatar and select “Groups” from the pieshaped menu. In the
Groups window that appears, scroll down to the group you want, and then click the “Activate” button.
Group Titles can be up to 21 characters long.

GTeam – n, “Governance Team”; The name of the internal group of Linden Lab employees who
oversee matters of law, conduct, and governance throughout Second Life.

Havok – n, The physics engine for the Second Life that handles realtime interaction between objects
or other characters.

Help Island – n, An optional postOrientation Island new resident learning area. To handle the large

number of people joining Second Life, there are a large number of Help Islands which are mirror
images of each other. These are referred to as HI1, HI2, HI3, etc. Once you leave Help Island, you can
not return, though you can go to Help Island Public

HetGrid – n, Short for Heterogeneous Grid, this is the technology that allows Linden Lab to update
server simulator code on a few regions at a time instead of over the entire grid at once. In theory, this
should make server upgrades smoother and avoid some gridwide shutdowns for server software
upgrades.

HI – n, Abbreviation for Help Island, q.v.
Home – n, The location that you teleport to when you choose the menu item “Teleport Home” or when
you “die.” You can set this location with a menu command. Home may be set to land that you own,
land that a group you are a member of owns, or Linden Land that is set to allow home to be set (such as
Welcome Areas or InfoHubs).

Homestead Region – n, A type of region for light use, with a capacity between an openspace region
and a regular region. A homestead region can support 3750 prims and 20 avatars at any one time.
Compare with regular regions and Openspace regions (q.v.).

Hover Text – n, The text that a script can cause to appear floating above an object. Hovertext is
generated with the llSetText function of LSL.

HUD – n, Head Up Display; a control panel for an AO or other device that appears on screen.
Icehouse – See Studio Icehouse.
IM – 1. n, Instant Message; the chat window that allows two or more players to speak privately. 2. v,
To instant message another resident or group of residents.

IM Coma/IM Trance/IM Hell – n, A state in which one person is not moving, chatting, or
responding to chat because he or she is being bombarded with IMs.

Infohub – n, A Linden Labowned information and social area. Infohubs are located at some of the

former Telehub locations and are built and managed by residents or resident groups. Some new players
first spawn at Infohubs after leaving Orientation Island or Help Island.

Inventory – n, The window that contains everything you possess that isn't manifest in the world. Your
inventory is the collection of clothing, objects, textures, etc. that your avatar possesses. Your inventory
travels with you, and you can use any of it at any time.

Inverse Kinematics – n, A technique used in avatar animations to calculate how various avatar joints

should be moved in order to result in a desired ending position.

Invisiprim – n, An object that is worn as an attachment to make part or all of an avatar (and other
objects behind it having Alpha Channels) appear invisible.

InWorld – 1. adj, The state of being connected to the Second Life servers and present in the Second
Life world (also: online). 2. adj, Anything that takes place within the virtual environment of Second
Life.

IRL – adj, “In Real Life”
Island – n, A Sim or group of Sims that are detached from the Linden Lab owned Mainland and only
accessible by teleportation (see Private Island).

IWorld – n, "InWorld," a group of Linden Lab employees involved in support, communication, and
education regarding inworld issues or queries. "I" also stands for "International", as the group also
supports residents whose first language is not English.

JIRA – n, Refers to the online issue and bug tracker at http://jira.secondlife.com . Here you can find

bugs that have been reported, enhancements requested, and discussions about them between residents,
Lindens, and other developers. Residents may vote for the issues they feel should receive attention.

Kick – 1. v, The forced logoff of a resident from Second Life by an administrator. An administrative
kick is usually followed by a timeout period, during which the kicked resident will be unable to log
into Second Life. 2. v, The expulsion of a resident from another resident's land by the landowner (see
Eject).

KK – In chat, equivalent to “OK”.
Lag – n, The condition of running slowly. This can be caused by the server, the client, your internet
connection, or the objects, scripts and activities of the players around you. Also see Time Dilation.

Landban – v, To ban from a parcel using the SL client ban tools available to land owners and
authorized members of groups owning land.

Land Baron – n, A resident who makes profit inworld by buying and selling land, or by developing
and selling land on Private Estates, q.v.

Landbot – n, An alt account run by a program designed to quickly purchase land sold below a set
price. Land that is incorrectly priced too low, or is set to sell for a nominal sum to “anyone”, will
almost certainly be snapped up by a landbot.

Land Griefing – v, The practice of buying land adjacent to a victim, placing deliberately ugly or

offensive items (such as Ad Cubes) to blocking the view from (or access to) their land, then attempting

to sell the adjacent parcel to the victim at an extortionate price. Land Griefing is not AR'able (as Linden
Lab is unwilling to restrict what a resident may place on land they own) unless the items placed on the
land violate the Community Standards or Terms of Service in some way.

Landmark – n, Inventory items acting as shortcuts to places in Second Life. If you double click on a

Landmark, a window pops up that allows you to see that location on a map or to teleport directly there.
You can create a landmark anywhere it is permitted by using a menu command, and can then be given
to other players. Landmarks you create or save default to being stored in the Landmarks folder of your
Inventory.

LCS – n, Local Coordinate System, q.v.
LDPW – n, “Linden Department of Public Works,” a group within Linden Lab responsible for

organizing teams of resident content creators to improve the beauty and experience of living on and
visiting Second Life mainland.

Liaison – n, A Linden staff member who works as frontline technical support or serves as an inworld
representative.

libopenmv – n, Previously called “libsecondlife” and “libsl,” an open source library of reverse

engineered software written in C# under .NET in Windows or Mono on multiple platforms, covered by
BSD license and not affiliated with Linden Lab directly. It is used to construct clientside software for
connecting to SL or OpenSimtype virtual world servers. Often used to create textonly clients, or
lightweight bot controlling clients.

libsecondlife – n, Obsolete name for libopenmv, q.v.
Linden – 1. n, An employee of Linden Lab. Linden employees are referred to as “Lindens” because all
of them have that last name when in the game. 2. n, Linden dollar, the currency of Second Life.

Linden Dollar – n, Denoted L$, the unit of currency for all monetary transactions in Second Life.

Lindens are a microcurrency and can be traded for real world currencies on the LindeX and on other
third party exchanges.

Linden Lab – n, The creators of Second Life. “Linden Labs” is a common – but incorrect – usage.
LindeX – n, A currency exchange operated by Linden Lab. Residents are able to buy and sell Linden
Dollars (q.v.) using US dollars, at market price, or place limit orders.

Link – v, When building, multiple prims may be linked together with a menu command. When linked,
they can be moved as one unit.

Link Set – n, Also “linkset”, an object consisting of two or more prims linked together.

Live Help – n, A now discontinued feature of Second Life. The “Live Help” command on the Help

menu allowed you to access inworld help chat with Lindens and Live Help resident volunteers. Live
Help has been superseded by the support portal on the SL website.

LL – n, Abbreviation for Linden Lab, q.v.
LLNet – n, A private global fiber optic networking infrastructure, invented by Linden Lab, for
connecting the Linden Lab servers and databases in several data centers.

LM – n, Abbreviation for Landmark, q.v.
Local Coordinate System – n, A way of describing locations in the world relative to an object. The

LCS of a particular object has its origin point <0,0,0> at its center, and the three coordinates
correspond to the forward, left, and upward directions from the object's point of view. This is as
opposed to the Global or World Coordinate System (GCS or WCS) in which everything is defined by
absolute position in the world. For example, if a human lies down on the floor on their left hand side
with their head facing North, then in GCS terms their head would be described as “West of their
shoulders”, since this is their literal position; in the person's LCS, their head would still be described as
“above their shoulders,” since this is its position relative to the rest of their body.

Local Lights – n, A feature built into newer graphics cards that helps render the glow of light sources
very fast. Older graphics cards must simulate the glow of local lights using software algorithms, which
can degrade performance on the client. This feature can be enabled/disabled in Preferences.

Lock – v, To set the lock flag for an item, making it unmodifiable.
LOD – n, “Level of Detail.” Refers in general to the algorithms that determine what level of detail

(resolution) that must be rendered for each object, avatar, and other component of a scene. Related to
Draw Distance, (q.v.)

Log – 1. n, A transcript of chat, or of computer activities. 2. v, To log out, to go offline, to stop
playing Second Life.

LOL – v, “Laughing Out Loud.” Shorthand meant to convey that the writer is actually sitting at the
computer laughing at something someone has said or done. “That's some silly cheese hat you have
there! LOL!”

Lot – n, Also called Parcel, a contiguous section of land owned by one person or group. Size is
measure in meters squared (m2). Cf. estate, region, sim, and parcel.

LSL – “Linden Scripting Language.” 1. n, The programming language used to create interactive

content inside Second Life. 2. n, The frontend compiler and backend execution environment for
executing LSL scripts (as opposed to Mono, for example). Both definitions are used in the sentence,
“LSL scripts may be compiled and run by LSL or by Mono.”

LSL2 – n, Alternate name for the version of LSL scripting language currently in use in SL. See LSL.
Lucky Chair – n, Scripted chairs that give out prizes when you sit on one that is displaying the first
letter of your first name.

m2 – 1. adj, Abbreviation for square meters used in talking about Second Life land. 2. n, Abbreviation
for the Metaverse Messenger newspaper.

Mainland – n, The continents managed by Linden Lab. Land on the mainland is initially auctioned off
by Linden Lab in one sim blocks.

Map – 1. n, The window in the Second Life application that displays the map. It can be used to find
locations, individuals, and specific coordinates. 2. v, To select an avatar's name in the map window so
that the avatar can be located, or followed, on the map. Mapping will only work on Avatars on your
Friends list that have set their client to allow you to map them.

Map Window – n, The window in the Second Life application that displays the map. It can be used to
mark locations, individuals, and specific coordinates.

Material – adj, Second Life objects can be made of different materials; this setting affects the

collision sound, weight, friction, etc. of the object. Example materials are Stone, Wood, and Rubber.
Material setting only affect the physics of the object and do not affect its appearance.

Mature – adj, Rating for a sim that allows behavior forbidden in the PG areas. This may include
profanity, nudity and sexual content and activities, to the extent that such behavior is legal.

MDC – n, See Metaverse Development Company.
MegaPrim – n, Prims that are larger than what is normally allowed, meaning that they have a

dimension over 10m along one or more axes. At one time, megaprims could be created using tools
invented by the libopenmv effort (q.v.), but Linden Lab changed the server software to prevent new
ones from being created. The existing megaprims were copied, transferred, and are still available today.
Currently there is limited simulator support for megaprims. Their existence may cause simulator
problems in some sims and so are not welcome everywhere. There is some movement within Linden
Lab to support megaprims officially to some degree in the future.

Mentor – n, A resident volunteer working with Linden Lab of Second Life who teaches and guides
other citizens.

Metaverse – n, A term for a virtual universe coined by Neal Stephenson in his 1992 science fiction
novel Snow Crash. Stephenson's novel was an inspiration for Second Life.

Metaverse Development Company – n, A realworld business which charges other businesses real

money to develop areas or promotions for them in Second Life. Prominent MDCs include: Electric
Sheep Company (ESC), Millions of Us, Beta Technologies, Aimee Weber Studios, and Rivers Run
Red.

MicroPrim – n, Prims that have been tortured (q.v.) into shapes that appear to have dimensions
smaller than the 0.01m dimensions normally allowed for prims. These are often used to make
attachments such as jewelry. Also called Tiny Prim.

Missing Image – n, A black and while error texture that appears on an avatar or object when the

Asset Server can't locate the correct texture. Missing Image problems on Avatars can often be fixed by
Rebaking (q.v.).

Mono – An open source framework for executing .NETcompatible software on a wide range of

operating systems. Linden Lab is currently integrating Mono into the Second Life server software. This
will give several advantages: (a) allow LSL scripts that are compiled under Mono to execute much
faster; (b) eventually will allow additional languages such as C# to be used for scripting in SL; (c)
increased security will make it harder for scripts to crash a sim. The alternative to Mono is OSE, q.v.

Mouselook – n, Typing the letter “m” will change the main window to a firstperson camera view that
will change according to mouse motions. This is the usual view for weapons fire and operating some
vehicles. Hit the Escape key to exit Mouselook. Also called Mouseview.

Mute – v, Choosing the option that prevents you from seeing the chat, instant messages, inventory
drops, and teleport offers from another player.

Neko – n, Mostly human avatars with some catlike characteristics, such as ears, whiskers and/or tails.
Has its origins in Anime.

Newbie – n, A newcomer to Second Life; a resident who has joined for a relatively short period of
time and/or is not familiar or comfortable with Second Life's culture, interface, and nuances. The
newbie cutoff point is generally considered to be at around 90 days.

Nicholaz Client – n, An alternate version of the open source Second Life client developed by SL

resident Nicholaz Beresford to attempt to fix bugs in the standard client and to provide those fixes to
the community prior to an official release.

Night – n, The default SL day is four hours long, consisting of three hours of daytime and one hour of
nighttime. The default cycle may be overridden on private estates.

NoCopy – adj, Any object whose permissions do not permit the current owner to make additional
copies of the object. These objects have (nocopy) in their name in the inventory.

NoFly – adj, Any land parcel that does not permit flying. You can fly through nofly parcels, but as

soon as you touch down and stop flying, you'll be unable to fly again until you exit the nofly parcel. If
you get really stuck, teleport somewhere else.

NoModify – adj, Any object whose permissions do not permit the current owner to make changes of
the object. These objects have (nomodify) in their name in the Inventory. Abbreviated nomod.

Non Physical – adj, A method of avatar movement obtained by sitting on a nonphysical prim and

then moving the prim with the edit tools, or using a script in the prim for controlled movement. A non
physical avatar can pass through walls and cannot be pushed; they are considered an immovable object
from the point of view of any physical object that strikes them. Abbreviated nonphys.

Notecard – n, An inventory item containing text and/or embedded textures, snapshots, objects, or
other notecards. Items embedded in notecards must have copy/modify/transfer permissions.

NoTransfer – adj, Any object whose permissions do not permit the current owner to resell or give
away the object. These objects have (notransfer) in their name in the Inventory.

Occlusion – n, 3D graphics rendering technique that ensures that the computer does not spend time

attempting to draw things that are not visible (typically because they remain hidden behind something
else).

Office Hours – n, Scheduled times where specific Lindens are available to take questions and
comments from residents on their specific areas of expertise.

Offline – adj, The state of being disconnected from the Second Life servers and absent from the
Second Life world.

OGP – n, “Open Grid Protocol.” Refers to the software protocols used for interconnecting clients with
Second Life regions and regions of other virtual worlds.

Oldbie – 1. n, A resident from the early days of Second Life (pre2005). 2. n, Anyone who is no
longer a newbie. The newbie cutoff point is generally considered to be at around 90 days.

OMG – “Oh My God!”
Online – adj, The state of being connected to the Second Life servers and present in the Second Life
world. Also: inworld.

OOC – adj, “Out of character.” A roleplaying shorthand used in roleplaying sims to let the listener
know that the avatar is speaking as him or herself – not as the character he or she is playing.

OpenMV – n, See libopenmv.
OpenSim – n, An open source project to create a virtual world similar to Second Life. The Second

Life viewer can be used to connect to OpenSim grids, but OpenSim servers cannot currently connect to
the Second Life grids. Also see OGP and AWG.

Open Source – adj, Software that has been licensed and published in such a way that the general

public can see it, understand it, develop it, improve it, and expand it. Modified versions of the software
may be redistributed within certain limitations. Currently the Second Life client (viewer) is open
source, but not the server software.

Openspace Sim – n, A sim (region) for very light use, with a dramatically reduced prim limit (750

prims) that operate four sims (regions) on a single sim processor. Designed by Linden Lab for creating
open fields or seas, they are sold for about one quarter of the price of one ordinary Sim. Also called
Void Sim. Also compare with Homestead (q.v.) regions.

Orbiter – n, A physicsbased weapon that attacks a resident by rapidly pushing them upwards into the

sky with a force that exceeds the amount of counterforce that normal Second Life flight can exert.
Orbiters send their victims so far into the sky that it would take hours for them to fall back down in the
normal way and/or their coordinates no longer fit within SL's world model. Normally, teleporting away
or – in extreme cases – relogging (q.v.) will fix being orbited.

Orientation Island – n, Abbreviated OI, the first area all users of Second Life visit. To handle the

large number of people joining Second Life, there are a large number of Orientation Islands which are
mirror images of each other. These are referred to as OI1, OI2, OI3, etc. Both Linden Lab and partner
companies operate Orientation Islands. Private OIs usually differ considerablely from the Linden OI.

OSE – n, “Original Script Engine,” Linden Lab's preferred term for the classic compiler and runtime
software used to compile and run LSL scripts. The other option is Mono.

Outfit – n, A group of clothing items in a single folder in Inventory that can be dropped on the avatar
to effect a fast change of appearance.

Packet Loss – n, Fragments of network data that get lost or mangled during transmission, for a wide
variety of reasons. Reducing the Network Bandwidth in Preferences may reduce packet loss, with the
tradeoff that all data will be transferred more slowly.

Parcel – n, Section of land within one region that is treated as one lot. All land within a parcel shares

the same owner, prim limit, About Land settings, ban lists, etc. A person can own more than one parcel
in a region, and it is possible (though unlikely) for a parcel to be not contiguous. An estate consists of
one or more regions (sims); a region (sim) consists of one or more parcels.

Particles – n, Twodimensional sprites (graphic images that always face the viewer). Second Life's

particle system allows a wide variety of particles, enabling residents to create burning fires, glistening
waterfalls, vapor trails on jet fighters, tracers on bullets, the occasional macabre spurt of blood, floating
hearts of affection, billowing smoke, rainbows, and much more.

Partner – n, A resident of Second Life who “partners” up with another resident; partners can be
spouses, couples, or just friends. It costs 10L$ to Partner with someone, and 25L$ to dump them.

Path Cut – n, A type of shape modification that can be applied to prims of various shapes using the

building editor in the Second Life viewer. A path cut in a sphere, for example, can result in shapes such
as a lemon wedge, hemisphere, etc.

Peak Usage – n, The maximum total amount of land a Second Life resident owned, at any one time,

in a monthly billing period. To reduce possible exploitation of land ownership, Second Life bills land
use fees based on peak usage; holding 4096 square meters for one minute costs the same as holding it
for thirty days. Note that this amount always includes the resident's group contributions as well.

Permissions – adj, Second Life's builtin “intellectual property” system. Creators can choose whether
subsequent owners of their creations can Copy, Modify, and/or Transfer that item. Creators who want
to preserve their intellectual property rights usually limit one or more of these attributes. Abbreviated
perms.

PG – adj, Describes an area that does not allow profanity, obvious sexuality, or intentional nudity.
Phantom – adj, Setting on a Second Life object which determines whether the object collides.
Phantom objects appears insubstantial, and can be freely passed through.

Physical – adj, Objects that have their “physics” flag set are subject to simulated Newtonian effects.
These objects will bounce, collide, and be affected by gravity,

Physics – 1. n, Second Life's software model for how forces and objects interact (see: Havok). 2. n, A
setting on objects that can be enabled, causing the object to fall and react to gravity, as well as
collisions with other objects. Without physics, objects remain exactly where they were placed, no
matter what force is applied to them.

Ping – n, v, A measurement and the act of measuring the time it takes for one fragment of data to

travel between two points on a network. Ping times between the client and simulator can be seen in the
Statistics Bar (q.v.).

Plywood – 1. adj, The default texture applied to all newly rezzed Prim. 2. n, A Second Life comic
strip by Moriash Moreau.

Pose – n, A static animation that puts your avatar into a specific position.
Pose Ball – n, Balls that contain scripts and animations that can make your avatar sit, dance, as well as
do many other things. Used by clicking on the ball and selecting “Sit Here” or “Animate” from the
menu. Usually colored blue (for men) and pink (for women).

Posing Stand – n, Standing on this item locks your avatar in position. Used primarily for editing the
position of attached items like hair and jewelry while being worn.

Premium Account – n, Paid subscription to Second Life. Premium Accounts cost between US$9.95

and $6.00 a month (depending whether they are paid monthly, quarterly, or annually), and provide a
Stipend (q.v.) of 300L$ a week and 512m2 of Tier (q.v.). A Premium Account is required to own land
on the Mainland.

Preview Grid – n, Previously known as the Beta Grid, an alternate set of servers that run an

independent copy of some of the sims using server software that is under development and has not yet
been released. Residents may log onto the Preview Grid to experiment with new software features. Any
activities, including monetary transactions, that occur on the Preview Grid are only temporary and are
confined to the Preview Grid and have no effect on your inventory or L$ balance on the main grid.

Prim – n, Short for “primitive” the basic shapes that almost all objects in Second Life are made from.
An object consists of a single primitive or multiple linked primitives. Prims are created, shaped, and
textured via the Edit window or by scripts. The basic Prim types are: Box, Cylinder, Sphere, Ring,
Tube, and Torus.

Prim Bonus – See Simulator Object Bonus.
Prim Flicker – n, The condition where two textures seem to overlap and shift one over the other as
you move around them. Prim flicker is caused by badly positioned overlapping sections of prims.

Prim Hair (or eyelashes, or fingernails.) – n, Hair made from twisted and textured prims. You can

generate a basic nonprim hairstyle with the avatar appearance sliders, but a wig made of prims looks
much more realistic.

Prim Limit – n, The number of prims that can be rezzed on a given parcel of land at any one time.
Prim Sculpture – n, v, Use of overlapping, modified prims to create artistic, realistic, and/or organic
shapes. The term “Prim Sculpture” originated well before Sculpties (q.v.) were introduced, to describe
skill at working around the fact that custom prim shapes were not available at that time; thus, Sculptie
Prims are (paradoxically) not generally referred to as Prim Sculptures.

Prim Taxes – n, A now discontinued feature of Second Life. Before Second Life 1.2, the amount of
prims residents could have in world was limited by “taxes” on each prim deducted from the Avatar's
account when prims were rezzed.

Prim Torture – 1. v, A method for adjusting settings of a Prim which are not normally accessible, by
switching the prim between different types. For example, you can set a prim to type Tube, adjust the
Profile Cut setting, and then set the prim to type Box. The result is a Box with a Profile Cut applied,
which is usually not possible. 2. v, Extreme deformations of prims.

Private Continent – n, A large group of privately owned sims.
Private Estate – n, One or more privately owned sims.

Private Island – n, A sim not connected to a mainland continent, owned by someone other than
Linden Lab.

Profile – n, The window that contains personal information about a avatar. The Profile window can

contain a picture of the avatar, a list of the groups they belong to, a description. Additional Profile tabs
include space for a website, Picks, Classifieds, a First Life section, and a Notes section.

Puppeteering – n, The ability to manipulate avatar joints in real time in expressive ways beyond
classic avatar movements, including ragdoll physics and inverse kinematics.

Push Weapon – n, scripted object capable of applying a force to objects, but especially to other

residents. come in numerable styles and implementations. Using Push Weapons on other residents can
be considered harassment and is not permitted in Safe zones or nondamageenabled regions.
Landowners have the option to cause Push Weapons not to work on their land.

Pyogp – n, Software for the OGP project written in the Python language. See OGP.
Radar – n, A scripted gadget, often worn as a HUD, that periodically reports a list of avatars who are
near you.

Rating – n, A now discontinued feature of Second Life. Ratings once were the positive or negative

vote a player could give to another player for their avatar's appearance, the player's building ability and
how well the players relates to others.

Ratings Bonus – n, A now discontinued feature of Second Life that paid stipend bonuses to people
with high Ratings.

RAW Terrain File – n, A specially formatted graphics file that defines the land contour of a region,

water height, and other land characteristics. Estate owners may create their own custom RAW files and
upload them to create their own island shapes and land contours.

Real World – 1. n, Also called Real Life, an imaginary, dreamlike world frequently described by
avatars shortly after waking up inworld. 2. n, The constant interruptions that interfere with your
ability to stay inworld 24 hours a day.

Rebake – v, To force one's clothing and body textures to rerez in order to correct blurred or “Missing
Image” problems with one's avatar. The rebake command is accessible via the Character submenu of
the Client menu. Also see bake.

Recent Items – n, Items that were most recently added to your inventory will show on the Recent

Items tab in your Inventory. Click the Recent tab, then choose "Show filters" from the inventory File
menu.

Region – n, A land area, syn. sim, q.v. An estate contains one or more regions (sims); a region (sim)

contains one or more parcels.

Region Domain – n, The part of Linden Lab server software that manages a region. This is almost the
same as a “sim,” but emphases the abstract separation between services that are required to support a
region as opposed to services that support avatars.

Region Say – v, A form of chat that objects are able to generate on nonzero chat channels and is
heard by all other objects residing in the same sim.

Rehi  Idiomatic shorthand for “Hello, again.” Usually spoken to someone who is seen again within a
short time of a previous conversation. “Rehi, Kathy. How was supper?”

Release Candidate – n, A version of the Second Life client currently being tested on the Main Grid
for a nearfuture release.

Relog – v, To log out of Second Life and then immediately log in again. Occasionally necessary to
clear up technical problems.

Reset – v, To restart one or more scripts inside an object. If an object is in edit mode or selected by a
right click, you may select “Reset All Scripts in Selection” in the Tools menu to restart the scripts in
the object.

Resident – n, Term for a person who uses Second Life. This can refer to the user of the account as
well as their inworld avatar.

Rez – 1. v, To create an object, or bring an object out of your inventory into the world. 2. v, Rez also

refers to textures, objects and avatars loading when you enter a new area, i.e.,“I teleported to the island,
but it took forever for the buildings to rez.” (Derives from “derez” a fictional hacker term in the movie
Tron.)

Risk API – n, Refers to a set of behindthescenes algorithms that run on the grid servers to try to

identify patterns of financial transactions that might indicate money laundering, fraud, identity theft, or
other illegal activity.

RL – See Real Life.
Rollback – v, n, The act of and the result of restoring a region to the state it was in at the time of an
earlier backup. This is something that Linden Lab can do in severe emergencies to get a corrupted
region restored to a working condition.

Root Prim – n, In an object consisting of multiple, linked prims, this is the prim last selected before
linking, and has special characteristics of importance to the operation of scripts.

Run – 1. v, A mode of avatar movement; CtrlR toggles between normal avatar walking speed, and

“running.” 2. v, To execute a program. 3. n, A longitudinal failure pattern that happens to legwear in
First Life.

Ruth – 1. n, The default avatar that is rendered on the screen by a client when the shape information

has not yet been received from the sim server, named for the female avatar with red swept back hair
originally used for that purpose. Currently, a “ruthed” avatar is represented by a soft particle cloud. 2.
v, Being “ruthed” is Second Life slang for appearing in the shape of the default SL Avatar (normally
due to server lag or dropped packets). To deruth yourself, go into Appearance mode, make a very
minor change, and then save that change, or log out and back on, or change shapes, or do any other
operation that triggers the shape information to be downloaded fresh from the sim.

Rx Team – n, “Resident Experience Team,” a group within Linden Lab responsible for improving the
new user experience. Also see SLUX.

Safe – adj, Describes areas which are set initially to not allow avatars to take damage. Individual
landholders can enable damage on their own land, however.

Sandbox – n, An area reserved for building activities. A sandbox must have the necessary land area,
prim allotment, and parcel permissions to allow users to rez objects and/or run scripts.

Script – n, A program that is written Second Life's Linden Scripting Language (LSL). A script can be
placed into an object to cause it to have an effect on the object and those people or things around it.

Scripted Item – n, An object that contains a program that allows it to behave in various ways. Scripts
and animations are the “life” of Second Life.

Scripter – n, A person who writes scripts in LSL, the Linden Scripting Language.
Scrubber – n, A type of script that, when placed in a prim, resets the persistent properties of the prim
to their default states. These properties include hover text, particle effects, sit target, etc.

Sculptie – n, Also called Sculpted Prim, a prim with a customized shape, created outside of Second
Life using 3D modeling software. Scultpies are a clientside effect and are rendered by the SL client
based on a special type of texture map.

Second Life – n, An interactive 3d virtual world almost completely built by the residents operated by
Linden Lab of San Francisco. Abbreviated SL.

Security Orb – n, A scripted object programmed to eject or teleport unwanted avatars from a land
Parcel (q.v.).

Server – n, The processor that runs the programming necessary for one region of the world. Multiple
regions (sims) are run on different processors in the same computer. Also called a Simulator.

Sex Balls – n, Linked sets of pose balls that animate avatars to show sexual behaviors.
Shield – n, Worn as an attachment, this surrounds the avatar with a transparent object designed to
intercept bullets, missles, push objects, or other items of threat to the avatar.

Shout – v, The act of saying text that can be heard by other avatars and scripts within a 100m radius.

Scripted items are able to shout, and avatars may shout by pressing the Shout button after entering text
in chat mode. Compare with regular chat (20m radius) and whispering (10m radius).

Showcase – n, A tab in the Search window in the Second Life viewer that lists a number of landmarks
selected by Linden Lab that demonstrate the best of Second Life resident locations.

Silks – n, A type of extremely revealing lingerie worn by Gorean (q.v.) slave girls, loosely based on
descriptions given in the original Gor novels. Silks have moved out from the Gorean subculture and
into the more general SL fashion industry, and are worn at times many nonGorean female avatars.

Sim – 1. n, Also called a “region,” a piece of Second Life land comprising 65,556 square meters

(256m x 256m). 2. n, Also called “simulator,” the physical computer server that runs multiple
instances of the simulator software. 3. n, An instance of the software that runs on a simulator server
that manages a single land region. (In Second Life, a sim refers to a server, server software, or region
of land, but never an avatar or character.)

Sim Boundary – n, The border between two sims. Crossing sim boundaries can cause problems, as
your avatar and its settings are transferred from one server to another.

Sim State – n, A snapshot of a region, including all the objects, terrain, scripts, and other things in a

region. Sim states are periodically saved and backed up by each sim server and used to recover a region
after a crash. Alternatively spelled “simstate.”

Simulator Object Bonus – n, A special setting on Private Islands which allows the Prim Limit (q.v.)
on some parcels to be increased. However, the sim owner must “pay back” the extra prims by leaving
other areas of the sim empty.

Sit – v, To sit on something, rightclick the object then choose "Sit" from the pieshaped menu.

Sometimes that slice of the pie menu might say something other than Sit (like Relax, Cuddle, or
Dance). This will access an animation that is embedded in the object that you clicked on. The same
process is used to run many animations in SL – not just to sit down. Also see Pose Balls.

Sit Target – n, The coordinates, as offsets from a prim's center, and the local rotation of where an

avatar will be positioned when seated on the prim. Newly created prims have a default sit target and
only a script can change it. Once changed by a script, the modified sit target will remain in effect even
if the script is removed.

Skin – n, A texture image that replaces the default skin of your avatar. Cannot (usually) be adjusted by

the appearance sliders, but looks much better than the default skin.

Skybox – n, Any building located up in the sky, instead of on the ground.
SL – n, See Second Life.
SLED – n, The mailing list for Second Life educators and those interested in the educational potential
of Second Life.

SLGOGP – n, “Second Life Grid Open Grid Protocol.” See OGP.
Sliders – n, Controls for customizing Avatar appearance and clothing. These sliding settings levers in

appearance mode (rightclick on Avatar & select “appearance” to access) change values for avatar and
clothing mesh. As an example, foot size can be altered from tiny to large on one slider, rounded to
pointy toes on another, thin to thick platforms on another.

SLT – “Second Life Time.” The time zone corresponding to the local time at the Linden Lab offices at
San Francisco. Linden Lab now refersto Pacific Daylight Time (PDT) and Pacific Standard Time
(PST), but the term SLT is commonly used inworld by residents

SLURL – n, A type of weblink that launches the Second Life client and teleports you to the location
indicated via the slurl.com website.

SLUX – n, Abbreviation for the Second Life User Experience. Refers to the mailing list and activities
of the Rx Team, q.v.

Spam – n, An unsolicited instant message, notecard, texture, group invite, animate request, or object
sent to multiple people. This can be sent by another player, or by an object containing a script.

Statistics Bar – n, A window of detailed performance data that appears on the upper right corner of
the user's screen, enabled with CtrlShift1 or View>Statistics Bar. The data can help identify the
source of performance problems in the client or simulator.

Stipend – n, The money given to a resident by Linden Lab on a weekly basis. Premium accounts

receive Stipends (300L$/week), though some older accounts have been grandfathered in under previous
stipend programs.

Streaming Music/Video – n, Music and video that may be heard and viewed on a parcel. Each

parcel may have one video and one audio stream set at any one time. Streams are specified as URLs to
files or streaming servers on the Internet. With the proper permissions, an avatar can manually specify
the URL of the streaming audio and video in the Media tab of Preferences, or by using a script to set
those fields.

Studio Icehouse – n, An engineering group in Linden Lab focused on the architectural underpinnings

of Second Life.

Target Omega – n, One of two techniques used by LSL scripts to make an object appear to spin on

one or more of its axes. Target omega spinning is computed and rendered by the client. The other way
to make an object spin is physical rotation, which is managed by the server side.

TekkieWiki – n, Derogatory term for users with advanced technical knowledge or experience of
Second Life, who are alleged to be unable to empathize with those who lack similar knowledge.

Telehubs – n, A now discontinued feature of Second Life. Telehubs were centralized teleport

locations in Second Life. Before SL version 1.7, pointtopoint teleporting was not enabled. Teleports
all landed at the nearest Telehub to the destination point. From there, you had to fly to your destination.
Most Telehubs were eliminated, but some were converted into Infohubs.

Teleport – 1. v, To transport oneself instantly to another location. In Second Life, you can teleport by
clicking on a landmark, using the map window, responding to a teleport request, or by selecting
“teleport home” from the World menu. Abbreviated TP. Also used as a verb meaning offer me a
teleport (“Ohthat sounds cool; TP me over please.”). 2. n, An offer to teleport an individual to your
location, e.g., “please send me a TP.”

Temporary – adj, Objects marked in Second Life as not being permanent. When an object is marked
as temporary, it will be deleted a few minutes after use. This is great for things like gun projectiles,
dominos, or beach balls that might get away from you, disappear somewhere, or end up on noscript
land (where their script would prevent them from deleting themselves).

Terms of Service – n, The set of rules that all residents agree to follow while using Linden Lab
services or products, and the consequences of violating those rules. Abbreviated TOS. Also see
Community Standards.

Terraform – v, To change the shape and elevation of land. Most Mainland sims are limited to ± 4
meters terraformability. Land on Private Estates can be terraformed up to ± 100 meters.

Texture – n, An image or graphic uploaded to Second Life for application to the surface of an object

or to clothing. Textures can be purchased or found for free inworld, or created in thirdparty graphics
programs and uploaded to Second Life for L$10 per image.

Tier – 1. n, The monthly land “tax” you pay to either Linden Lab (on the mainland) or to a private

island owner to own land. The more land you own, the higher your monthly Tier fees, but the less you
pay per square meter (m2). Premium members get 512 m2 of free mainland tier. 2. n, One of the levels
of land ownership (and associated land use fees).

Tier Up – v, To raise the level of tier you pay monthly to Linden Lab. Tiering up allows you to own
more land and/or make a higher tier contribution to a Group.

Time Dilation – n, A simulator tries to update all the physics effects in a sim 45 times a second.

When the sim cannot make these calculations fast enough, time seems to slow down. Avatars, vehicles,
and other things move more slowly than normal. The time dilation is shown in the Statistics Bar (q.v.),
and can be read by scripts.

Tiny– n, An extremely small Avatar, usually a furry, designed to resemble an animated stuffed animal.
Tiny Prim – n, See Micro Prim.
Tooltip – n, The information that appears when a mouse pointer is moved over an item or avatar. Slide
the mouse arrow (without pressing any mouse buttons) over the item and the tooltip will appear, telling
you the name or cost of an item, or the name of an avatar.

Tortured Prim – n, A prim that that has been modified into a shape that is normally not possible. (see
Prim Torture)

TOS – n, See Terms of Service.
Town Hall – n, A meeting where a senior Linden addresses and takes questions from residents. Town
Halls are usually conducted via voice.

TP – see Teleport
Traffic – n, A Linden Lab generated measure of how many avatars frequent a parcel of land and how
long they stay. Higher traffic results in a higher placement in the “Places” search. (see Camping).

Triage – n, In Second Life, refers to several weekly meetings of Linden Lab developers and residents

to discuss the priorities of fixing outstanding bug reports and enhancement requests. Bug triages occur
in SL life in conjunction with the office hours meetings of several Linden Lab employees.

TTYL – “Talk To You Later”
TY – “Thank You!”
UUID – n, Globally unique identifier assigned to each item in the SL asset server database. Every

avatar, object, texture, clothing item, body part, notecard, sound, animation, snapshot, gesture, etc. has
its own UUID. Also known as a Key.

UX – n, “User Experience,” See SLUX.
VBO – n, “Vertex Buffer Objects.” This is a feature in most newer graphics cards that can

substantially improve client rendering performance, but may cause problems with some hardware. It
can be enabled/disabled in Preferences.

Vehicle – n, A scripted object whose movement you can control. Typically, a resident will sit on/in the
vehicle and use it as a form of transportation. Vehicles include cars, airplanes, hoverboards, boats,
UFOs, and much more.

Vendor – n, A scripted object that designed to sell objects, clothing, or other items to residents. Many
brands of vendors are networked and operate of a central server.

Void Sim – n, See Openspace Sim.
Voting Machine – n, A machine that is usually marked “Vote” that allows a visitor to register

approval for the owner's building. Voting machines were once tied into the nowdiscontinued SL
“Dwell” system where money was awarded to the owner of the property according to how many votes
occurred the previous day.

VTeam – n, The name of the internal group of Linden Lab employees who coordinate the volunteer
programs throughout Second Life.

VW – “Virtual World”
WarpPos – n, A scripting technique used in teleporters. This allows avatars to be teleported farther
and faster than other techniques.

WB – “Welcome Back!”
Wear  v, To attach prim clothing or other items to your avatar. You can wear an item by dragging it

from inventory onto your avatar, or right click the item in inventory and choose "Wear." Choose "Add
to Outfit" to wear all the items in an inventory folder. The creators of wearable items typically set a
default body part or attachment point for the item which you can change if necessary. To stop wearing
an item, right click it and choose "Detach" or choose Edit>Detach Object if it is primbased, or right
click your avatar and choose "Take Off" or click Edit>Take Off Clothing to remove a nonprim item.

Webkit – n, Lindenfunded replacement for Mozilla as the inworld browser embedded in the viewer.
Welcome Area – n, Abbreviated WA, a Linden Labowned and designed information and social area.
The two largest Welcome Areas (Ahern and South) are located at the intersection of four sims to
support a large number of people, and are surrounded by Lindenowned greenspace. Some new players
first spawn at one of the Welcome Areas after leaving Orientation Island or Help Island.

Whisper – n, Speech (usually by objects containing scripts) that is audible only within a 10 meter

radius from the object. Compare with regular chat (20m radius), shouting (100m radius) and Region
Say (simwide).

Wiki – n, A collaborative, editable website for sharing information. Linden Lab's official wiki is http://
wiki.secondlife.com and contains a wealth of information (mostly technical) written by Linden

employees and residents.

Windlight – n, Sky and atmospheric and lighting effects for Second Life, developed by Windward
Mark Interactive, which was purchased by Linden Lab for their technology. This technology can be
seen, for example, when the “Atmospheric Shaders” are enabled in Second Life client graphics
preferences.

Wire Frame – n, adj, A mode of viewing the world by seeing only the edges that connect the vertices

of objects, avatars, and terrain. The client wire frame mode can be toggled on and off with CtrlShiftR.

XAxis – n, The EastWest axis of the inworld coordinate system. Increasing X values point east.
YAxis – n, The NorthSouth axis of the inworld coordinate system. Increasing Y values point north.
Yiff – v, Slang term for furry sex.
ZAxis – n, The updown axis of the inworld coordinate system.
Zoning – adj, Limits to what may or may not be placed on given areas of land. Almost all Mainland

sims have no zoning (other than PG or Mature), but many private islands / estates / continents do. Also
see Covenant.

